
 

 
 
 
 
 
 

Jaguar IV Series 
User Manual 

 
       

 
 
 
 
 
 

   http://www.GCCworld.com 
 
 

V.2.5 Oct. 10 



V.2.5 Oct. 10 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NOTICE 
 

GCC reserves the right to modify the information contained in this user  
manual at any time without prior notice; un-authorized modification, copying 

distribution or display is prohibited. All comments, queries or 
suggestions concerning this manual please consult with your local dealer.   

 
 
 
 
  



                                                                                   Jaguar IV User Manual 
 

Important Information                         

 Important Information                      
  Thank you for purchasing the GCC Jaguar IV Cutting Plotter.  

Before you use the cutting plotter, please make sure that you have read the    
safety precautions and instructions below.  

              Caution

!
SAFETY PRECAUTIONS!  

 For safety concern, please always hold the cutter firmly from the bottom while moving 

it.  Do not move the cutter by clasping the depression area on both sides.  

 

                        
 

 

  

O  (Correct)    X  (Incorrect)   

 Do not shake or drop the blade holder, a blade tip can fly out.  

 During an operation, do not touch any of the moving parts of this machine (such as the 

carriage). Also be careful to make sure that clothing and hair do not get caught.  

 Always connect the power cable to a grounded outlet.  

 Always use the accessory power cable which is provided. Do not wire the power cable 

so that it becomes bent or caught between objects.  

 Do not connect the power cable to branching outlet to which other machines are also  

     connected, or use an extension cable. There is danger of overheating and of  

      mis-operation of the machine.  

 Keep the tools away from children where they can reach.  

 Always put the pinch rollers within the white marks.  
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Warning   
 

Never press the top release grip and pull the bottom release grip at the same time as 

the pictures shown below:  

 

 

       O  (CORRECT)               ╳  (INCORRECT)  
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Press down 

DISABLE 

Press down  

 
Stop bar  

ENABLE  

Note: 

In case the grips clipped 

together due to your 

wrong operation, please 

use a tweezers to pull 

out the stop bar when 

pressing down the top Pull up bottom to release grip  
release grip. Keep the 

stop bar outside then 

release the grips as the 

right figure.  
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1.1 Introduction 
Jaguar IV series cutting plotters have been designed to produce computer-generated images 
or perform contour cutting on sheets or rolls of vinyl media.  
 
This manual covers the following models of Jaguar IV series cutting plotters: 

‧J4-61 for media width: 50mm(1.97”) ~ 770mm(30.3”) 

‧J4-101S for media width: 50mm(1.97”) ~ 1270mm(50”) 

‧J4-132S for media width: 50mm(1.97”) ~ 1594mm(62.7”) 

‧J4-183S for media width: 300mm(11.8”) ~ 1900mm(74.8”) 

 
1.2 Package Items 
The package of the Jaguar IV model contents the items listed below, please check carefully.  
If you find any item missing, please consult your local dealer for further assistance.  

SSttaannddaarrdd  IItteemm  QQuuaannttiittyy  

1. Cutting Plotter 1 
2. Stand Set ( for J4-101S/132S/183S only )(Optional for J4-61) 

 2 piece of T-shape stand  
 1 piece of stand beam 
 18 pieces of M6 screws 
 1 piece of M5 L-shape hexagon screw driver 
 1 piece of Installation Guide for Stand Set 

1 

3. Flexible Media Support System Package 
Items S 1 183S/132S/101 6
1 set of Roll Media Flange (2 pieces) V V 
1 set of Roll Holder (2 pieces) V V 
1 set of Roll Holder Guide Bushes (4 pieces) V V 

1 set of Roll Holder Support (2 pieces) V V 
1 piece of M6 L-shape hexagon screw driver V V 
1 piece of Installation Guide for Roll Holder  V 

1 piece of M5 L-shape hexagon screw driver  V 

1 set of Desktop Support Brackets (2 pieces)  V 
4 pieces of Plastic Foot  V 
4 pieces of M4 screws  V 
12 pieces of M6 screws  V 
1 piece of M4 L-shape hexagon screw driver  V  

1 

1. General Information                                 
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4. Accessories 
 1 piece of User’s Compact Disk 
 1 piece of AC power Cord 
 1 piece of data cable (RS-232C)  
 1 piece of data cable (Print cable) 
 1 piece of data cable (USB cable) 
 1 set of Blade Holder Assembly (Installed in tool carriage of the cutting 

plotter) 
 1 piece of Blade (Installed in Blade Holder) 
 1 piece of Safe Blade 
 1 piece of Cutting Pad for Vinyl cutting 
 1 piece of Tweezers 
 1 piece of Promise Card 

1 

 
 
1.3 Product Features  
 
The following are the main features of the Jaguar IV series cutting plotters: 
 
‧ Tri-port connectivity provides you with greater flexibility 
‧ Up to 600-gram cutting force  
‧ Up to 60-inch/per second cutting speed 
‧ Guaranty 10-meter tracking  
‧ User friendly, multi-language control panel 
‧ Ingenious media basket (optional item) 
‧ Enhanced Accu-Aligning System for automatic contour cutting 
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1.4 Appearance of Jaguar IV 
 
1.4.1 The Front View (Figure 1-1) 
 
 
 

 
 
 
 
 

Control panel – consists of 14 

control keys and 1 LED and 1 LCM 

showing messages and menus. 

Cutting Pad – provides the 

protection of blade when the blade is 

cutting. 

Tool Carriage – performs the 

cutting with the installed blade 

and pen with AAS module. 

Slicer Groove – 

slice off the extra 

media easily along 

this groove. 

Platen – provides the 

surface for holding and 

supporting media while 

performing cutting. 

Grid Drums – move 

the media back and 

forth during operation.  

Alignment Rulers – 

media can be aligned 

with the clear guide line 

marks. 

Figure 1-1  
 
1.4.2 The Back View (Figure 1-2) 

 Figure 1-2 

Lever –  

raises or lowers the 

pinch rollers. 

Pinch Rollers –  

hold the media during 

cutting. 
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1.4.3 The Whole View of Jaguar IV (Figure 1-3) 
 
 
  
 

 

  
 
 
 
 

 
 
 

Roll Holder – holds 

and supplies the roll 

media for cutting. 

Roll Holder Guide 
Bushes – serve to 

keep the roll media in 

place when media is 

pulled from the roll. 

Roll Holder 
Support – supports 

roll holders. 
 

 
 

 
 
 
 
 
 
 

 
 
 
 

 
 

T-Stand –supports 

the cutting plotter 

Stand Beam – 

stabilizes the body.  

Figure 1-3 

T-Stand –supports 

the cutting plotter 
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1.4 4 The Left-hand Side (Figure 1-4) 

              

Fuse – 3 Amp.

Power Switch – On when switches to [I]; Off to [O] 

AC Power Connector – used to insert the AC power cord. 

 
  
 
Figure 1-4 

 
 
 

1.4.5 The Right-hand Side (Figure 1-5) 
 

 

Figure 1-5 

USB Connector – used to connect the cutting 
plotter to a computer through a USB cable.  

Serial Interface Connector (RS232C) – used 
to connect the cutting plotter to a computer 
through a serial interface cable.  

Parallel Interface Connector – used to connect 
the cutting plotter to a computer through a 
parallel interface cable. 
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 2. Installation                                  

2.1     Precaution 
 
Please read below information carefully before you start installation.  
 
Notice 1 

 Make sure the power switch is off before installing the cutting plotter.  

 Carefully handle the cutter to prevent any injuries. 

 

Notice 2  Choosing a proper place before setting up the cutting plotter 

Before installing your cutting plotter, select a suitable location, which meets the following 
conditions. 

 The machine can be approached easily from any direction. 

 Keep enough space for the machine, accessories and supplies. 

 Keep the working area stable, avoiding sever vibration. 

 Keep the temperature between 15 and 30℃ (60-86oF) in the workshop. 

 The relative humidity of the working environment should be between 25% to 75%.  

 Protecting the machine from dust and strong air current. 

 Preventing the machine from direct sunlight or extremely bright lighting.  

 

Notice 3  Connecting the Power Supply 

Check the plug of the power cord to see if it matches with the wall outlet. If not, please contact 
your dealer. 

 Insert the plug (male) into a grounded power outlet. 

 Insert the other end (female) of power cord into the AC connector of cutting plotter. 
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2.2    Stand & Flexible Media Support System (for J4-101S/132S/183S) 
 
 
Step 1 
Please examine supplied items in the accessory box of stand carton:  

 2 piece of T-shape stand  
 1 piece of stand beam 
 18 pieces of M6 screws 
 1 piece of M5 L-shape hexagon screw driver 
 1 piece of Installation Guide for Stand Set 

 
 
Step 2 

 Remove the plotter body and the accessories from the shipped carton. 
 Place the stand beam upright on the T-stand and follow the number  to 

assemble. 
 (See Figure 2-1 & 2-2)  
 
 

 

 T-Stand

 Stand beam 

Figure 2-1 

 

Figure 2-2  
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Step 3 
Position the stand beam perpendicularly to part and put the screws into the holes and 
tighten them as Figure 2-2. Then the complete picture of stand will be like Figure 2-1. 

 
 
Step 4  
Remove the cutting plotter from the carton. Position your stand under the plotter, and then 
insert the screws into the holes on plotter’s bottom and tighten them up as shown in Figure 
2-3. 

 
 

Figure 2-3 

Screws 
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Step 5 
Insert the roll holder support with the screws into the holes of the stand, and then tighten them 
up as shown in Figure 2-4. You could decide roll holder support’s position by inserting into 
different holes.  

 
 

 
Figure 2-4 

 

3 screws 

Roll holder 

Step 6 
Place two roll holders into the holes in the roll holder support. (Figure 2-5) 

 

Roll holder support 

Roll holders 

Figure 2-5  
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Step 7 
Lastly, the complete picture will be shown like below. (Figure 2-6) 

 
 

Figure 2-6  
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2.3    Desktop Flexible Media Support System (For J4-61 only) 
 
Step 1  
Please examine the following items in stand carton’s accessory box:  

 1 set of Roll Media Flange (2 pieces) 
 1 set of Roll Holder (2 pieces) 
 1 set of Roll Holder Guide Bushes (4 pieces) 
 1 set of Roll Holder Support (2 pieces) 
 1 set of Desktop Support Bracket (2 pieces) 
 4 pieces of Plastic Foot 
 4 pieces of M4 screws 
 12 pieces of M6 screws 
 1 piece of M4 L-shape hexagon screw driver 
 1 piece of M5 L-shape hexagon screw driver  
 1 piece of M6 L-shape hexagon screw driver (for adjusting the screws of Roll Holders) 
 1 piece of Installation Guide for Roll Holder 

 
Step 2                       
Put the 4 Plastic Foot under the Roll Holder Support and insert the M4 screw into the hole of 
Plastic Foot and tighten them with the M4 L-shape screw driver. (Figure 2-7)                       
 
 

Figure 2-8 

M4 screws 

Roll Holder Support  

Plastic 

Figure 2-7 
M4 screws 

 

Roll Holder Support 
M6 screws 

 

Desktop Support Brackets 

 
 

M6 screws
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Step 3   Position the Desktop Support Brackets beside the Roll Holder Support and insert 
M6 screws into the Roll Holder Support and tighten them with M6 L-shape screw driver. (Refer 
to Figure 2-8 at the left). 
Step 4  
Put the bottom of machine in lateral, and position the Roll Holder Assembly beside the bottom 
of the machine. Then, insert the M6 screws into the holes of Roll Holder support assembly 
and tighten them with M6 L-shape screwdriver. Like Figure 2-9.  
 

 
M6 screws   

 
 
 
 
 
 
 
 
 
 
 Figure 2-10 Roll Holders  

Screw holes 

Roll Holder Assembly 

Figure 2-9 

 
 
Step 5  

lace the two roll holders into the holes of Roll Holder Support (Figure 2-10).  P
 
 
Step 6  

he complete Desktop Media Support System will be shown as in Figure 2-11.  T

 Figure 2-11 
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2.4    Blade Installation 
 of the blade 

holder and remove the blade by pushing the pin.  Make sure that your fingers are away from 
the blade tip.  

Figure 2-12 is the illustrator of the blade holder.  Insert a blade into the bottom

 Pin 

Outward ring

Adjustment depth knob 

 
 
Step 1 
Install blade (Figure 2-13).  
 
 
 
 
 
 
 
 
Step 2

ush the blade to the bottom of the blade holder. (Figure 2-14).  
 

P
 
Step 3 
Adjust the blade tip to suitable length by screwing 
“Blade tip adjustment screw” clockwise or  
ount-clockwise. (Figure 2-15).  

 

 
c
 
 
 
 
 
 
 
 

Figure 2-15 

Figure 2-14 

Tips: 
“The proper length” means the blade’s 
length is adjusted 0.1mm more than 
film’s thickness. That is, if the thickness 
of film is lade’s length is 
properly adjusted 0.6mm and it can 

t through the film layer yet 
avoid penetrating the backing. 

ure 2-12 Fig

0.5mm, then b

completely cu

Figure 2-13 
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Step 4  
te the outward ring of the holder must put 

 

             Figure 2-16                                   Figure 2-17    
                         

Insert the blade holder into tool carriage. Please no
into the grooves of carriage firmly (see Figure 2-16), then fasten the case (Figure 2-17). 

                    
Step 5  Use the reversing steps to remove the blade holder. 
 
Step 6  Eject the blade. Push “B
replaced.   

lade eject pin” to eject blade when the blade needs to be 

 
Caution 
The blade will lose its sharpness after a period of  
By increasing the cutting force, it might do the 
and no longer provides a reliable cutting, y
consumable and must be replaced as often as nec  
quality of the blade deeply affects cutting quality. So  
e

.5    Cable Connection 

tter communicates with a computer through a USB (Universal Serial Bus), Parallel 
ort (Centronics), or a Serial port (RS-232C). This chapter shows you how to connect the cutting 

 host computer and how to set up the computer/cutting plotter interconnection. 

led 

 usage, the cutting quality might be affected. 
trick. However, once the blade is worn out  

ou should replace a new one. The blade is  
essary to maintain the cutting quality. The 

 be sure to use a high quality blade to 
nsure good cutting results. 

 
 
2
 
The cutting plo
p
plotter to a
 
!! Notice: When USB connection is enabled, both parallel port and serial port will be disab
automatically.  
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.5.1 USB Interface 
aguar IV build-in USB interface are based on the Universal Serial Bus Specifications 
evision 1.1. (Operation syst  don’t support USB ).  

 
 USB driver installation 

 

 

 

Use the USB One-click Installation for quick dr
below for driver setup. 

Connecting your GCC cutter 
nnector to the machine and then USB driver will installed 

automatically.  
 
 
 
 

 

 
 

 

 

Parallel port  
Serial port 

 
2
J
R em of Windows 95, Windows NT

iver installation. Follow the simple steps 

 
 
Step 1:  

1. Connect the USB co

 
 
 
 

Figure 2-18 
USB port 

Caution!! 
 If you are using Windows 2000 / XP / Vista / 7 as your operating 

system, make sure you log in using the “Administrator” 
account. 

NOTE 
ck that the USB mode option under [ MISC ] → [ USB Printer Type ] men

o Common U

Che u is 

set t SB Mode before running the installation. 
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Step 2: Installing the software 

vice is 
re you start the driver installation. 

(1) Put the installation CD into your CD-ROM. Please make sure that the USB de
connected befo

 

 
 

) Choose the model you want to install from the driver list and click on either the 32 bit 
or 64 bit driver installation depending on the operating system installed on your 

on. (The Expert Pro model is used as an illustration in 

(2

computer to start the installati
the following steps.)  
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NOTE 
If you use the Windows 7 / Vista 64 bit program, please note that a 
pop-up window will be shown upon the initial installation as shown below:

 
 Click “Yes” to continue. 
 

 
 
 
(3)

 

 Click “Next” 
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(4) The installation will take a few minutes to complete and you will see a message below 

and click on “OK” upon completion. Enjoy your GCC cutter! 
 
 
 
 

 
 

Note: 
(1) If the driver is being installed for a second time, the user will be prompted as to whether a 

second copy of the driver installation is required. 
 

 

 
 
(2) If the user selects yes, a second copy of the driver will be installed. 
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2.5.2  Parallel Interface 
 

 Connecting to the Parallel (Centronics) Port 

1. Connect a parallel cable to the cutting plotter and the host computer  
. Set up the output port LPT1 or LPT2 from your software package 

s like TYPE or PRINT 
to output data. 

 
Caution!! Please turn off the plotter before plugging the print cable. 

2
3. Send the data to your cutting plotter directly. Or, use DOS command

 
 
2.5.3 RS-232 Interface 

 Connecting to the RS-232 (Serial) Port 

. For IBM PC, PS/2 users or compatibles, connect the RS-232C cable to the serial 
connector of the assigned serial port (COM1 or COM2) of your host computer.  

. Set up the communication parameters (Baud Rate and Data Bits/Parity) to match the 
setting of software package, refer to chapter 3 – “Misc” key description. 

Caution!! Please turn off the plotter before plugging the RS-232C cable. 

 

1

2

 

 
 
2.5.4  Data Transmitting 

nsmit the data from the computer to the cutting plotter:   

ta can be transmitted from your application 
. 

HP-GL/2 commands. 

cisely. 

 

There are two options to tra
 
Option 1: With proper interface settings, the da

software package to the cutting plotters directly
 
Option 2: Most cutting software packages are able to emulate HP-GL or 

As long as the file is HP-GL or HP-GL/2 format, the cutting plotter can output the 
data pre
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This chapter describes the button operations with the LCM menu flowcharts of Jaguar IV. When 
the cutting plotter is ready for use as described in Chapter 1 & 2, all functions are under default 
parameters.   
 
3.1    The LCD Panel 
 

SPEED FORCE OFFSET

MISC TOOL SELECT DATA CLEAR CUT TEST
ON/OFF 

LINE PAUSE / RESUME ENTER

POWER

 
< LCD Control Panel on Jaguar IV series > 

 

Key Function 

LCD Screen To display functions and error messages. 

Power LED To indicate the power status ( light up: power on; light off: power off )

4 Arrow Keys To move position, select function, or change setting. 

ENTER To set item or register the immediately preceding input value. 

PAUSE/RESUME To temporarily halt cutting process or to continue 

ON/OFF LINE To switch modes, stop cutting job, or abort changes of settings. 

OFFSET To adjust the value of blade’s offset. 

FORCE To adjust the value of cutting force. 

SPEED To adjust the value of cutting speed and quality.  

CUT TEST To perform cutting tests in different ways. 

DATA CLEAR  To clear up buffer memory. 

TOOL SELECT To select tools. 

MISC To set up functions. 
Please see details in “3.4 Menu Items” 

3. The Control Panel                             
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3.2    Menu in On-line Mode 
Power On   Jaguar IV in processing  

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Jaguar IV 
Firmware:    Copyright: 

Place Media And Then Lower 
Down The Lever 

Roll      Edge       Single 
  

Sizing Media Width Lever Up 
To Abort 

Sizing Media Length Lever Up 
To Abort 

Pause  Setup   Resume 

S--- F----- O----  

L-------- W-----T1M 

Sending data 

[PAUSE ] 

[ FORCE] Force:80 gf 
          OK:ENTER 

use    to select; [ENTER] to enable the setting

[ SPEED ] Speed:       72 cm/s 
Select:    OK:ENTER 

UP Speed:   72 cm/s 
Select:       OK:ENTER  

Quality:      normal 
Select:      OK:ENTER  

[ OFFSET ] Offset: 0.275 mm 
          OK:ENTER 

[ DATA CLEAR ] Clear Data Memory 
N:Cancel     OK:ENTER     

[TOOL SELECT ] 1S:72   F:80  O:0.275 M 
Select:        OK:ENTER 

Set Smoothing Cut 
Select:     OK:ENTER  

OverCut:      0.00mm 
Select:        OK:ENTER 

Pouncing      0 mm 
Select:       OK:ENTER 

Top menu 

Set Tangential Mode 
Select:     OK:ENTER 

use     to select 

GCC Cutter 
LCM Version- - - 
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使用       选择 

3.3    Menu in Off-line Mode 
Press [ON/OFF LINE] to switch to the offline mode 

 
 
  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Offline For        
System Setup 

[ FORCE] Force:80 gf 
          OK:ENTER 5~600 with an increment of 5(gram force) 

[ OFFSET ] Offset: 0.275 mm 
          OK:ENTER 0.000~1.000 with an increment of 0.025(mm) 

[ DATA CLEAR ] Clear Data Memory 
N:Cancel     OK:ENTER     

           move origin     
X:             Y: 

[          ] 

[ SPEED ] 
Speed:       72 cm/s 
Select:       OK:ENTER Speed:3~153 with an increment of 3(cm/s) 

UP Speed:   72 cm/s 
Select:       OK:ENTER UP Speed:3~153 with an increment of 3(cm/s) 

Quality:       normal 
Select:       OK:ENTER Draft, Fair, Normal, Fine, Small Letter 

Square Cut 
Select:         OK:ENTER 

Repeat Last Plot  
Select:         OK:ENTER  

[CUT TEST ] 

[TOOL SELECT ] 

Scale Width  
Select:       OK:ENTER  

Scale Length  
Select:       OK:ENTER  

Select Unit 
Select:       OK:ENTER 

Select Language  
Select:       OK:ENTER 

Set Communication  
Select:       OK:ENTER 

Paper Saving Mode  
Select:      OK:ENTER 

[ MISC ] 

Both Expanded Mode、Length Expanded Mode、
Width Expanded Mode、Both Unexpanded Mode  

English,Chinese 

Metric (cm/gf) or English 
measurement (inch/oz)

Auto Unrolled Media  
Select:       OK:ENTER 

Media Back & Forth  
Select:       OK:ENTER 

AAS Offset 
Select:       OK:ENTER  

Vacuum  
Select:       OK:ENTER 

Firmware： x.x.xx 
FPGA：Vx.x      mm/dd/yy 

USB Printer Type 
Select:       OK:ENTER  

1S:72   F:80  O:0.275 M 
Select:        OK:ENTER 

OverCut:  0.00mm 
Select:       OK:ENTER  

Pouncing        0 mm 
Select:       OK:ENTER 

Set Tangential Mode 
Select:       OK:ENTER 

Set Smoothing Cut 
Select:       OK:ENTER 

Restore default ? 
Select:       OK:ENTER 

Save parameter? 
Select:       OK:ENTER  

Pouncing:0-200mm with an 
increment of 1mm

OverCut:0.00-1.00mm with an 
increment of 0.05mm

Panel Setup  
Select:       OK:ENTER 

GCC USB Mode 
Common USB Mode
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3.4    Menu Items 
Below describes the functions of menu items 
Menu or Key Function Setting Default 

--- Media sizing --- 
Roll To measure media width. Maximum Tracking 

150 meters 
 

Edge To measure media width and pull the media back till the front 
paper sensor open. 

Maximum Tracking 
150 meters 

 

Single To measure media width and length. Maximum Tracking 
10 meters 

 

--- POWER --- 
 To indicate the power status.    

[ Arrow Keys ] 
  1. To move the tool carriage position on X or Y axis.         

2. To select functions or change values of settings. 
    

[ ENTER ] 
  1. The displayed parameters will be saved automatically.  

2. To set a new origin at the present tool carriage position. 
In “offline” mode, moving the tool carriage to desired 
position by [Arrow Keys], then press [ENTER] key to set a 
new origin. While moving with the parameters of XY-axes 
displayed, press [MISC] key will enable fine-tune 
movement; press [MISC] key again to disable the function.

    

[ PAUSE/RESUME ] 
  To temporarily halt the cutting process. 

To resume the process by press [Pause/Resume] key again.
    

[ ONLINE/OFFLINE ] 
  1. To switch between online mode and offline mode.  

2. To stop the cutting job or abort the change of setting.  
Once press this key, the cutting job will be terminated 
immediately and cannot be resumed. 

    

[ OFFSET ] 
  To set or modify the distance between the blade tip and the 

center axis.  
0.000~1.000mm 0.275mm 

[ FORCE ] 
  To set or modify the value of tool force.  5~600gram;      

5 gram/per step 
80 gram 

[ SPEED ] 
Speed To set or modify tool speed at horizontal moving. 3~153cm/sec;   

3cm/sec per step 
72cm/sec 

Up Speed To set or modify tool speed at vertical moving. 3~153cm/sec; 
3cm/sec per step 

72cm/sec 

Cutting Quality To set or modify cutting quality.                           
While cutting small letter, set as “Small letter”.             
While cutting in high speed, set as “Draft”. 
For normal operation, set as “Normal”. 

Draft, Fair, 
Normal, Fine,    
Small Letter 

Normal  

[ CUT TEST ] 
Square Cut To perform a cutting test at present blade position.          

For more information, please refer to “4.3 Adjusting the 
Cutting Force and Offset” to adjust blade force and cutting 
speed. 
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Recut: 
To repeat the last job without re-sending the data.           

1~99; 
1 per step 

 Repeat Last 
Plot 

Copy: 
To copy the last job without re-sending the data. 
 
* 1mm gap will be auto-generated between 2 copies). 
* If the media length is not enough to continue, it will show  

below message on LCM: 

O pOtu Sf a ;c e #
iCfo po e is f n hi s e d  

* If both functions are enabled at the same time, the cutter will
perform the last setting only.    

1~99; 
1 per step 

 

[ DATA CLEAR ] 
  To clear up buffer memory.     

[ TOOL SELECT ] 
Set Smoothing 
Cut 

To enable smooth-cutting function.   Enable 

Over Cut To generate an overcut to facilitate weeding.  0.00mm-1.00mm 
0.05mm/per step 

0.00mm 

Set Tangential 
Mode 

To enable the emulated tangential-cutting mode for thicker 
media types and small letter cuts.                         
Note: while the Offset value setting at 0.000 mm, “Set 
Tangential Mode” will automatically be disabled.  

  Enable 

Pouncing To make perforated patterns. 
* In order to use this function, Pouncing tool must be installed. 
* Before start pouncing, place pouncing strip on top of the 

cutting pad to protect the cutting pad. 
* Set the value as 0 mm to disable the pouncing mode.   
* Pouncing tool is an optional item.  

0~200mm 0mm 

Accept setup command: 
To accept commands of the Force, Speed, Cutting Quality, 
and Offset only via software. 

   Panel Setup 

Control panel only: 
To accept commands of the Force, Speed, Cutting Quality, 
and Offset only via control panel of the cutter.  

  

Restore Default To turn all parameters of the menu items to factory-default 
settings.  

  

Save 
Parameter 

To save pattern(s) of cutting parameters for later use.  Patterns1~4 Pattern 1 

[ MISC ] 
Auto Unrolled 
Media 

To avoid paper jam and motor crash by automatically unroll 
media (50cm and up) before cutting while enabled.  . 
* Auto-unroll only effects on roll/edge media.   
* Using Single mode to size media will disable this function 
automatically. 

* If the length of the rolled media is less than 2 meters or the 
weight is light, it is recommended to set this mode disabled.

  Enable 

Vacuum To help improve tracking and cutting accuracy by turning on 
the fans. If you turn off the vacuum system, the fans 
will remain inactive during cutting or plotting. 

 Enable 

AAS Offset To set or modify AAS offset value. 
You can refer to “5.3 Printer Test” for more details. 
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Media Back  
& Forth 

To enable to save time on repeated cutting jobs and better 
tracking. 
After cutting job has finished, the media will move back to the 
origin, then move to the end of the plot. 

  Disable 

Paper Saving 
Mode 

To save media by four different modes:                    
1. Length expanded mode   2. Width expanded mode       
3. Both expanded mode     4. Both unexpanded mode 

  Both 
unexpanded 
mode 

Set 
Communication 

To build up the communication between host computer and 
cutter.  
Baud Rate is to determine the speed of data transmission.  
Data Bits refers to the size of one block of data. 
Parity is used to check if data was revived correctly or not. 
9600, n, 7, 1, p  9600pbs, 7 Bits with NO Parity 
9600, o, 7, 1, p  9600pbs, 7 Bits with ODD Parity 
9600, e, 7, 1, p  9600pbs, 7 Bits with EVEN Parity 
9600, n, 8, 1, p  9600pbs, 8 Bits with NO Parity 
9600, o, 8, 1, p  9600pbs, 8 Bits with ODD Parity 
9600, e, 8, 1, p  9600pbs, 8 Bits with EVEN Parity 
19200, n, 7, 1, p 19200pbs, 7 Bits with NO Parity 
19200, o, 7, 1, p 19200pbs, 7 Bits with ODD Parity 
19200, e, 7, 1, p 19200pbs, 7 Bits with EVEN Parity 
19200, n, 8, 1, p 19200pbs, 8 Bits with NO Parity 
19200, o, 8, 1, p 19200pbs, 8 Bits with ODD Parity 
19200, e, 8, 1, p 19200pbs, 8 Bits with EVEN Parity 

  

Firmware 
Version 

To display the version number of Firmware and FPGA code.     

Select 
Language 

 To select displayed languages on LCM panel in English, 
Spanish, Italian, Deutsch, Japanese, Portuguese, Polish, 
Turkish or French. 

 English 

Select Units Provide two-unit systems for users convenient. cm/gram;  
inch/oz 

Metric 

Scale Length 

Scale Width 

 To adjust the scale of media length and width that may cause 
by the thickness of the media.   

 
The Denominator is the actual length, and the Numerator is 
the ideal length measured from the resultant.  

 
For example, cutting a line with 500.0 mm length. The 
procedure as follows:                                   
1. Press the [LEFT ARROW] to choose the Numerator and  

select 500.0 mm,                            
2. Cut the length by sending a graph file,         
3. Measure the length then use the [RIGHT ARROW] key to 

choose the Denominator, then     
4. Press [UP ARROW /DOWN ARROW] to change the values 

of the actual length. 

    

USB Printer 
Type 
 

To select USB Mode from the LCM panel. Two USB modes 
are available: GCC USB Mode and Common USB Mode. 

 
GCC USB Mode: For 32 bit driver  

[Windows XP/2000/ 7 /Vista]  
 
Common USB Mode: For 64 bit driver  

[Windows 7 / Vista] 
 

 Common 
USB Mode
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4. Operation                                   
4.1 Media Loading 
 
4.1.1  Loading the Sheet Media 
To load the media properly, please follow the procedures listed below: 
 
Step 1 
Use the lever on the upper right side of the cutting plotter to raise or lower down pinch rollers. 
Pull the lever forward until it makes a clicking sound then the pinch rollers are raised (Figure 
4-1). 

 
Lever  

 
 
 
 
 

Figure 4-1   
 
Step 2 
Load your media on the platen and slide it under the pinch rollers from either the front side or 
the backside. The alignment rulers on the platen extension will help you to adjust the media 
precisely.   
 

 
 
 
 
 
 
 
 
 
 
 
 

Note:  
Be sure that the media must 
cover the paper sensors on the 
platen when loading the media. 
At least one of the two paper 
sensors (Figure 4-2) should be 
covered. Once the media covers 
the sensor, the cutting plotter will 
size the media width and length 
automatically. 

Paper sensors 

Figure 4-2 
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Step 3 
Then move the pinch rollers manually to the proper position. Be sure the pinch rollers must be 
positioned above the grid drum. The white marks on the top trail will remind you where the grid 
drums are (Figure 4-3). White marks 
 

Figure 4-3 

 
 
 
 
 
 

 
 
 
 
Step 4 
Push the lever backward to lower down the pinch rollers. 
 
 
Step 5 
Turn on the power, the tool carriage will measure the size of the media automatically.  And the 
plotting cutter begins to work. 
 

Note: 
1. Always adjust the position with the pinch roller raised. 
2. Move the pinch roller by applying force at the rear portion of the pinch roller support. 
3. Do not move it by holding its front rubber roller (Figure 4-4). 

 
 
 

Incorrect  

(X)  
 
 
 
 
 
 

Figure 4-4 
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4.1.2  Loading the Roll Media  
Step 1 
Put the roll media guide bushes on two roll holders (Figure 4-5).  
 
 
 
 
 
 
 
 
 
 
 Step 2 
-- Option A (Recommended)  

Insert the two roll holders into the roll media support set then place the roll media directly 
between the two roll holders (Figure 4-6).         

 
 

 
 
 
 
 
 
 
 
 
-- Option B (Use the media flanges) 

Insert a roll media flange at the end of each roll  
media and tighten the thumbscrew until the roll  
media is firmly gripped(see Figure 4-7). 

 
Then put the roll media on the roll holders. Adjust the  
position of the roll media ensure that media flanges are  
able to run in the grooves of media guide bushes.  
(Figure 4-8) 

 

Figure 4-5 

 

Figure 4-6 

Figure 4-7 

Figure 4-8 
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Step 3 
Load the media on the platen. Please refer to “4.1.1 Loading the sheet media”.  After loading 
the roll media, flatten the media on the platen and hold the front edge of the roll media firmly 
(Figure 4-9).                                                             

                                            

Figure 4-9 
Figure 4-10 

 

Make sure that the media 
tension is equally distributed 
from left to right. If the media 
were not tightened enough 
against the platen, it would 
cause tracking problems!  

Note :  Step 4 
Turn the roll downward to make an equal tension 
across the media (Figure 4-10) 
 
Step 5 
Move the pinch rollers to the appraise location and  
note that the pinch rollers must be positioned above 
the grid drums.    
 
Step 6 
Push the lever backward to lower down the pinch rollers.  
 
Step 7 
Fix roll media guide bushes on the roll holder to secure the roll media. 
 
Step 8 
Turn on the power switch, the tool carriage will sizing the media automatically.  
Then the cutting plotter is ready to work.  
 
Step 9 
Use the reverse steps to remove the media. 
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4.2  Tracking Performance 
 
In order to achieve the best tracking performance for a long plot, we recommend some 
significant media loading procedures described as follows: 
 

If the media length is less than 4 meters, leave the margin of 0.5mm—25mm in the left and right 

edges of the media (Figure 4-11). 
 
 
 

0.5mm - 25mm 0.5mm - 25mm 

Pinch roller  

Figure 4-11 

Pinch roller 

 
 
 
 
 
 
 
 
 
If the media length is greater than 4 meters, leave at least 25mm margin on the left and right 
edges of the media (Figure 4-12). 
 
 
 

> or = 25mm > or = 25mm 
Figure 4-12 

 
 
 
 
 
 
 
 
Please refer to the paragraph “4.5 How to Make A Long Plot” for more details. 
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4.3    Cutting Force and Offset Adjustment 
 
Before sending your designs for cutting, you may perform a “cut test” to generate satisfactory 
cutting results. The “Cut Test” should be repeated until the appropriate cutting conditions for the 
media are discovered.  
 
After sizing the media, press [CUT TEST] button to select the “square cut”, and press [ENTER 
KEY] to confirm. 
 
The default cutting force and offset value of the cutting test are 80gf and 0.275mm respectively. 
Press [ARROW KEY] to move the tool carriage to the position where you like. Then, press the 
[ENTER KEY] to perform Cut Test. 
 
Note: At the same time, the new origin is also set at the cutting test position. 
 
When the cutting test is completed, a pattern appears. Peel off the pattern to see if it can be 
easily separated from the media base. If yes, the setup tool force is appropriate. If not or cut 
through the back paper, press [FORCE KEY] to adjust the tool force until an optimum force is 
obtained (Figure 4-13). 

 S q u a r e C u t

Press ENTER_KEY

AA CCBB

Press ENTER_KEY

E n t e r:O KS e l e c t :

M o v e t t ec u
X Y: :

Ms t

S q u a r e C u t

Press SPEED_KEY, 
FORCE_KEY, 

OFFSET_KEY to setup
or

Press arrow keys to 
desired position for next 

square cut

E n t e r:O K
C o n t

/N : O O F FN

Machine

3mm

80
 m

m

3mm

80
 m

m

Press ENTER_KEY

80
 m

m

Finish square cut

Press 
ENTER_KEY

Press ON/OFF 
line_KEY

i n o u s
L NI E

If the pattern appears to be BB or CC layout, 
press [OFFSET KEY] to adjust the offset 
value until AA pattern discovered. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 4-13 
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4.4   How to Cut 3mm Letters 
 
To obtain good quality output, narrow media is recommended. However, if wide media is used, 
you should: 
 

1. Position two pinch rollers as close as possible to both edges of the cutting area. 
2. Make sure the loaded media is held flat with equal tension across the platen. 
3. Suggested operation settings: 

Tool force: 55 gf. (or depending on the material) 
Cutting speed: 45-50 cm/sec 
Tool up speed: 45-60 cm/sec  
Smooth cut: Disable 
Quality: Small Letter 

 
 
4.5 How to Make A Long Plot  
 
When you are making a long plot with a roll of heavy and wide vinyl, paper you need to use the 
“AUTO UNROLL MEDIA“ function. The following parameter settings are to help users get the 
best cutting quality. The actual output quality may vary when using different kind of materials 
 

1. If the length of graphic is between 3m and 5m, the cutting speed is    
    better slower than 72cm/sec and the cutting quality is set as Normal. 
2. If the length is longer than 5m or if the material type is difficult to cut, it 

is better to further slow down the cutting speed. 
3. After loading the roll media all pinch rollers are raised at this stage,  
    flatten the media on the platen and hold the front edge of the roll media  
    firmly (Figure 4-14). 

  
  

 
  
  

 
 
 
 

Figure 4-14 
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Then turn the roll downward to make an equal tension across the media 
(See Figure 4-15) 
 

  
 

 

 
 
 
 
 
 
 

4. Engage pinch rollers. 

Figure 4-15 

Make sure that the media 
tension is equally distributed 
from left to right. If the media 
is not tight enough against the 
platen, it will cause tracking 
problems.  

5. Fixes roll media guide bushes on the roll holder to secure the roll media. 
6. The protrusion length of the blade should be longer than the thickness of the vinyl.  

(Please check the “Blade Specification: About the Tool” in Appendix.) After you 
notice all the above, you’ll enjoy your gigantic signs production! 

 
4.6    When Completing the Cutting Job 
 
After completing the cutting job, raise the sheet-loading lever, and then remove the material. 
You can also cut off the finished job by the Safe Blade (a standard accessory) along the knife 
guide. (Figure 4-16)  

 
Figure 4-16 
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Chapter 5 Accu-Aligning System 

 
5.1 Introduction 
 
The Jaguar IV series cutting plotters feature a standard Accu-Aligning System (AAS II) to 
guarantee precise contour cutting quality by detecting the registration marks printed around the 
graphic. 
 

Notice  
 Avoid any kind of light source horizontally illuminating the AAS module.  

                                                                                            
                          

                                       
                        - PROHIBITED                        - ACCEPTABLE 
 
 

 DO NOT take off the cover of AAS module while in operation. 

    
                       - PROHIBITED 
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5.2 AAS Calibrating the System 
 
The AAS system has one calibration procedures to ensure maximum accuracy of AAS 
operation. To operate the AAS you need to learn about the method of media feeding firstly. 
(Refer to 4.1 Media Loading.) 
 
5.2.1 Media Calibration  

Media Calibration is to ensure the sensor being able to recognize the registration marks. 
The factory default works on a wide range of materials. However, certain types of 
materials may not work properly. Performing a media calibration may become necessary 
while working with such materials to change the sensitivity of AAS for greater reliability.  
Media calibration adjusts the media feeding according to media type for better accuracy 
during cutting.  
 

 When to use 
We suggest white media for best cutting result. It is not necessary to perform media 
calibration every time unless the registration marks on the printed media become 
undetectable in AAS sensing process. 

 
5.2.2 AAS Calibration  

The first registration mark is designed to be different in order to identify the origin for AAS 
auto-detection. The following precaution must be aware for registration marks to be read 
automatically. 

 Type of media 
 Registration mark pattern 
 Reading range required for detection the registration marks 
 Position for registration marks and medium 

          The registration marks have to be: 
 Created by cutting software like SignPal or GCC CorelDRAW plug-in 
 In black color 
 “L” Mark Length: 10mm~50mm, suggested 25 mm 
 “L” Mark Thickness: 1mm~2mm, suggested 1 mm 
 Margin: 1mm~50mm, suggested 5 mm 

The cutter can not detect the marks while: 
 Cutter carriage is not located near the outside area of first mark before 

detecting (See the picture in page 5-7 for auto-detecting area of first mark.) 
 Medium thickness is more than 0.8mm 
 Transparent medium is used 
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 Non-monochrome drawing. The marks can’t be read if is printed on colored 
medium 

 Dirty or creased medium surface 
 
5.2.3 AAS II on Jaguar IV  
There are three types of AAS II mark patterns: 4-Point Positioning, Segmental Positioning, and 
Multiple Copies. Note that before print out your designs by inkjet printers, the registration marks 
have to be created on your graphic designs by cutting software like SignPal, EasySign or GCC 
CorelDraw plug-in. Hand-made marks or drawings won’t be reorganized by GCC cutting 
plotters. For more details about registration mark setting in cutting software, please refer to 
‘Appendix A-3 : CorelDraw Plug-In Instruction”, ‘Appendix A-4 : SignPal 8.5 Instruction’, 
‘Appendix A-5 : EasySIGN Instruction’ and ‘Appendix A-6 : GreatCut Instruction. 
 
1. 4-Point Positioning 

This is the basic mark pattern that AAS II will auto detect four registration marks and contour 
cut images inside those marks. 

 Command: Esc.D1;(XDist);(YDist): 
 Layout: 4 L-shaped marks at the 4 corners around the design 

 

2. Segmental Positioning 
In addition to 4 original points, the intermediate registration marks are added on both X axis 
and Y axis to help contour cut accurately, especially for cutting large images. 

 Command: Esc.D2;(XDist);(YDist);(XStep);(YStep): 
 Layout:  

In-between distance on X: 200~600mm, default 300mm 
In-between distance on Y: 200-600mm, default 300mm            
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3. Multiple Copies 

The function is used to duplicate images to let you cut quantities of images at a time.The 
AAS II sensor will automatically scan registration marks for each individual image to ensure 
the contour cutting precision.  

 Command: Esc.D3;(XCopies);(YCopies);(Space): 
 Layout:  

          Condition 1 (Default)                       Condition 2 

          
 

5.3 Printer Test 
 
Before performing AAS contour cutting, it’s recommended to print out a test file that you 
can find in the enclosed Installation CD to make sure the AAS II cutting accuracy of  
Jaguar IV. 
  
There are two testing files for AASII: 
1.    AAS II_X_Y_Offset_Caberation_A4 .eps (A4 size) 
2.    AAS II_X_Y_Offset_Caberation_600_600 .eps (Default setting, it is recommended 

for testing) 
  

 Print out the testing graphic. ( Please use high precision printer) 
 Load the graphic to Jaguar IV and sent the file to test the cutting job 
 If there is any adjustments had to be made, you can change the offset value by 

following the steps: 
＊ Measure the offset values from the printed line and the actual cutting line. 
＊ Enter the AAS Offset under MISC function for the values you just measured, 

then press Enter 
＊ Test the cutting again 
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＊ AAS II offset X and Y value is defined as following:       
Horizontal line is defined as X and vertical is defined as Y 

＊  When the actual cutting line and the printed line need to be changed 
towards the direction of origin mark, then simply add the negative value of 
the offset. If the direction is from the opposite of the origin mark, then enter 
positive values for the offset. This method apply on both X and Y axle. 

  
For example: 
If the values set in cutter is X: 0.50 mm  Y 0.50 mm and the measurement is 
X1:-0.25 mm   Y 1:+0.25 mm. (In following figure, the Blue Line refers to the Y Value, 
and the Red Line refers toe the X value.) 
We need to adjust AASII offset X new : (X + X1) Y new : (Y + Y1) which means X 
new : 0.25 mm  Y new : 0.75, then save the set new value to cutter. 

 
Note:  

  Before adjusting the AAS II settings, please proceed scaling for width and length. 
  The blade offset value isn’t set for this test graphic, please set it according to the 

blade you use. 
 If you have any question, please contact us or your local distributor for assistance. 
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5.4 Contour Cutting 
 
For accurate contour cutting with AAS function, please proceed the following steps: 
 
Step 1 Creating Graphics 
  ■ Create the graphic that you want to print and cut in your software. 
 
 
 

  ■ Create a contour for cutting around the graphic. 
 
 
 

TIPS1: Leave some space between the graphic and contour line. 
TIPS2: Create the contour in a separate layer and assign a different color for it. 

 
        ■ Add registration marks around the graphic. 
 

    Note: 
The Multiple Copies function is also available. It automatically copy the graphic and 
registration marks. 
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Step 2 Placing the Registration Marks 

 The AAS Layout Instruction: 

* Auto-detection function on the 1st mark covers the grey area 
 Suggested 30mm margin on both left and right sides of media sheet.  
 Suggested 20~30mm margin on top of media sheet, and at least 50mm margin on 

the bottom edge to prevent sheets dropping or any error occurred while media sizing. 
 
Step 3 Print the Graphics  
  ■ Print the graphic and the marks with your printer  

(Scaling = 100%).   
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  ■ When printing on a roll media, make sure the orientation as following: 
 

Step 4 Load the printout onto cutter 
  ■ The Origin Mark is is different from the rest registration marks. Please make sure the 

media is fed with correct direction. 

              
 
Step 5 Cut the Contour 
  ■ Send out the command from software to perform the contour cutting job. 
 
 
5.5  Tips for AAS 
 

For getting better results of contour cutting, there are some tips below for your reference. 
 

 Keep light sources simple and avoid illuminating from the sides of cutter. 
 Before operating AAS, change the maximum paper size in Jaguar IV driver 

property. 
STEP 1 Find the Puma III model in the “Printer & Fax” folder of your PC. 
STEP 2 Open the Properties window and select the “Paper” tab. 
STEP 3 Change the maximum Paper Size of X to 1200mm. 

 Adjust the cutting speed to between 300~600mm/sec. 
 Avoid the registration marks locating on the tracks of pinch rollers. 
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This chapter explains the basic maintenance (i.e. cleaning the cutting plotter) required for the 
cutting plotter. Except for the procedures mentioned below, all other maintenance must be 
performed by a qualified service technician. 
 
6.1 Cleaning the Cutting Plotter 
Cleaning the machine properly and regularly will ensure optimal performance out of your 
machine.  
 
Cleaning Precaution !  
 

 
 
  
  

Recommended Methods: 
 Gently wipe the cutting plotter surface with a lint-free cloth.  If necessary, with a damp cloth 

immersed in water or alcohol. Dry and wipe any remaining residue off a soft, lint-free cloth. 
 

 Wipe all dust and dirt from the tool carriage rails. 
 

 Use a vacuum cleaner to empty any accumulated dirt and media residue beneath the pinch 
roller housing. 

 
 Clean the platen, paper sensors and pinch rollers with a damp cloth immersed in water or 

alcohol, and dry with a soft, lint-free cloth. 
 

 Wipe dust and dirt from the stand. 
 
 
 
 
 
 

 Unplug the cutting plotter before cleaning it 
in order to prevent electrical shock. 

 
 Never use solvents, abrasive cleaners or 

strong detergents for cleaning. They may 
damage the surface of the cutting plotter 
and the moving parts.  

6. Maintenance                            
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6.2 Cleaning the Grid Drum 
 
 
1. Turn off the cutting plotter, and move the tool carriage away from the area needed to be 

cleaned. 
 
2. Raise the pinch rollers and move them away from the grid drum for cleaning. 
 
3. Use a bristle brush (a toothbrush is acceptable) to remove dust from the drum surface. 

Rotate the drum manually while cleaning. Refer to Figure 6-1. 
 
 
 

.3  Cleaning the Pinch Rollers 

. If the pinch rollers require a thorough cleaning, use a lint-free cloth or cotton swab to wipe 

. To remove the deeply-embedded or persistent dust, use the lint-free cloth or cotton swab 

 
 
 
6
 
1

away the accumulated dust from the rubber portion of the pinch rollers. To prevent the pinch 
rollers from rotating while cleaning, use your finger to hold the pinch rollers to prevent them 
from rotation 

 
2

moistened with rubbing alcohol. 
 
 
 
 
 
 
 

Figure 6-1 

Note: The daily maintenance of your cutting plotter is very important. 
Be sure to clean up the grid drum and pinch rollers regularly for better 
cutting accuracy and output quality. 
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 7. Trouble Shooting                                  
 
This chapter is to help you correct some common problems you may come across. Prior to 
getting into the details of this chapter, please be sure that your application environment is 
compatible with the cutting plotter.  
 
 

Note: 
Before having your cutting plotter serviced, please 
make certain that the malfunction is in your cutting 
plotter, not the result of an interface problem or a 
malfunction in your computer or a software problem.  

 
 
 
 
 
 
 
 
 
 
 Why is the cutting plotter not functioning?  
 
 
 
 
Possible Causes: 
 
7.1 Non-Operational Problems 

 
Check the following first: 

 Does the AC power cord plug in properly? 
 Does the AC power cord connected to the power connector properly? 
 Does the power LED still illuminate? 

 
Solutions: 
 

If the LCM is able to display the message, the cutting plotter should be in a normal 
condition. Switch off the cutting plotter and turn it on again to see if the problem still 
existing. 

 
If the LCM is not able to display any message, contact the technician from your dealer.   
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7.2    Operational Problems 
 
Some mechanical problems or failure during operation will cause some problems. The error 
messages shown on the LCM present the problem first, and followed by recommended actions. 
If the problem still exists after the recommended actions have been done, have your cutting 
plotter serviced.    
 
 This message indicates that there might be a 

problem on the X axis. Check if the drum is 
working well and if the media is well loaded.  
Correct the problem and re-power on to 
reboot system. 

Error, Check Media 
Or Drum or X Motor 

 
 
 

 
 
 
 
 This message indicates that there might be 

an obstruction to carriage relating to a 
problem on the Y axis.  Correct the problem 
and re-power on to reboot system. 
 

Error, Check Media  
Or Y Motor  

 
 
 
 
 
 
 This message indicates that the blade 

up/down sensor malfunction. Re-power on to 
re-boot system. If the problem still exists, find 
a serviceman. 

Error, Check Carriage  
Sensor or VC Motor 

 
 
 
 
 
 
 This message indicates that the cutting 

exceeds the cutting limit. Reload larger media 
or re-scale the plot to a smaller size; then 
press the key followed by the display of LCM 
to continue. 

Graph Was Clipped. 
Data In Buffer 
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7.3    Cutting Plotter/Computer Communication Problems 
 
The messages showed below present problems in relation to cutting plotter/computer 
communication. 
 
 

Communication Error 
Setup: MISC. key 

Yes No 

Is the connection cable 
connected to the cutting plotter 
and computer properly? 

 
 
 
 
 
 

Has the interface setting 
been done correctly? 

Refer to Chapter 2 - 
Connecting your cutting 
plotter. 

Yes No 

 
 
 
 
 

Try the communication 
between your cutting plotter 
and computer. If it still does 
not work, have your cutting 
plotter serviced. 

Refer to the “MISC” key in 
Chapter 3 - Description of 
Operation for the port setup.  

 
 
 
 
 
 
 
 

Note:  
The computer also needs to set up compatible communication 
parameters to the cutting plotter set up.  

 
 
 
 
 

If your cutting plotter can not recognize 
the HP-GL/2 or HP-GL commands, please 
check the HP-GL/2 or HP-GL commands 
applied to your cutting plotter are used 
properly.  

 
HP-GL/2 Cmd. Error  
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7.4    Software Problems 
 
Check the following first:  
 

No Yes 

Does your software package indicate that it will work with 
your computer and cutting plotter?   
Does your software support HP-GL and HP-GL/2 drivers? 
(* check the configuration settings of your software.)  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

No Yes 

Does the cutting plotter interface 
match the requirements of your 
software? 

Does your 
software 
recommend 
using a different 
cable? 

Yes No 

No 

Refer to Chapter 
2 - Connecting 
your cutting 
plotter. 
 

Most well known cutting softwares 
in the world have drivers for our 
cutting plotters. If not, use 
software that has HP-GL and 
HP-GL/2 emulation supports and 
you can chose the following three 
drivers: 

 A3 size: HP7475A 
 A1 size: HP7580A 
 A0 size: HP Draf Pro Exl or 

HP Draf Master 

Does the software 
vendor provide a 
sample file?  

 
 Yes 
 

Try using the 
recommende
d cable. 

 
 
 
 
 
 

Re-power on the 
cutting plotter and 
try to send the file 
again. 

Do something about the 
error message display on 
LCM, or consult your 
software vendor. 
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7.5 Cutting Quality Problems 
 
 

Note: The daily maintenance of your cutting plotter is very important. 
Be sure to clean up the grid drum and pinch rollers regularly for 
better cutting accuracy and output quality. 

 
 
 
 
 

Is the blade installed correctly and the blade 
holder fastened securely? 

Yes 

 
 
 

No  
 

Refer to Chapter 2.4 
“ Blade Installation” 

Is the blade dull 
or chipped? 

Yes 

 
 
 
 

No 

Replace 
with a new 
blade 

 
 

Is tool force set up 
properly? (The default 
for tool force is 80 gf) 

Yes 

 
 
 
 

No 

Adjust the tool force to obtain an 
optimum blade force. Refer to 
Chapter 4.3 “Cutting Force and 
Offset Adjustment” 

 
 

Is the tool offset set up 
properly? 

Yes 

 
 
 
 

No 

Adjust the tool offset to 
obtain an optimum value.

 
 

Is there any dirt adhered to 
the blade? 

Yes 

 
 
 
 

No 
 
 

Remove the blade 
and clean it. 

Please contact your dealer for technician 
support.  
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Jaguar IV Specification 
Model Number J4-61 J4-101S J4-132S J4-183S 

Operational Method  Roller-Type 

Max. Cutting Width 610mm (24in) 1016mm (40in) 1320mm (52in) 1830mm(72in) 

Max. Cutting Length 50m (164ft) 

Max. Media Loading Width 770mm (30.3in) 1270mm(50in) 1594mm(62.7in) 1900mm(74.8in) 

Min. Media Loading Width 50mm (1.97in) 300mm (11.8in) 

Number of Pinch Rollers 3 4 6 

Acceptable Material Thickness 0.8mm (0.03in) 

Drive Motor DC Servo Control 

Cutting Force 0~600 g 

Max. Cutting Speed  1530 mm/sec (60ips / Diagonal) 

Acceleration 4.2 G (gravity) 

Offset 0~1.0 mm (with an increase of 0.025mm) 

Memory Buffer  4 MB 

Interfaces USB1.1, Parallel and Serial (RS-232C) 

Type of Command HP-GL, HP-GL/2 

Mechanical Resolution 0.00625mm 

Software Resolution 0.025 mm 

Repeatability  ±0.1mm 

Curve & Arc Smoothing Yes 

Configurable Origin  Yes 

Test Cut capability Yes 

Tangential- emulation  Yes 

Repeat Yes 

Copy Yes 

Pouncing Yes 

Control Panel LCD (20 digits x 2 lines), 14 Keys, 1 Power LED 

Power Supply AC 100-240V, 50~60 Hz (auto switching) 

Power Consumption  Max. 110watts 

Dimension (HxWxD) mm      414 * 930 * 490    1166 * 1430 * 667  1166 * 1754 * 667   750 * 2170 * 1160 

(HxWxD) in     16.3 * 36.6 * 19.2 45.9 * 56.0 * 26.3 45.9 * 69.1 * 26.3 29.5 * 85.4 * 45.7 

Net Weight 37.2 kg 53.3 kg 61 kg 105 kg  

Stand Optional Standard 

Accu-Aligning System Standard AAS II 

Media Basket Optional 

Temperature 15°C~30°C / 60°F~86°F Operation 

Environment Humidity 25% ~ 75% 

 Compatible with Windows 2000/XP/7. 

 The specification and data sheet may vary with different materials used. In order to obtain the best output quality, please 

maintain the machine regularly and properly. 

 GCC reserves the right to change the specifications at any time without notice. 
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 Blade Specification 

For cutting thick fluorescent and reflective vinyl. Also for cutting 
detailed work in standard vinyl. 

20200159G 

The blade is 45° with Red Cap(5-unit package), 0.25 mm offset

 

For cutting reflective vinyl, cardboard, sandblast, flock, and 
stencil sharp edge. 

26500058G 

The blade is 60° with Green Cap, 0.50 mm blade offset 

 

For cutting thin sandblast mask and stencil with friction feed or 
sprocket feed machine. 

26500059G 

The blade is 60° with Blue Cap, 0.25 mm blade offset 

 

For Cutting small text and fine detail. Sharp blade with smallest 
offset. 

26500060G 

The blade is 0.175 mm blade offset with Black Cap 
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About the Tool 
 

A generic term referring to the blade that cuts the sheet, the pen that does plotting, and the 
LED bombsight (option) used for pointing to the reference point. 
OFFSET is the distance that the blade tip is displaced from the centerline of the blade. 
 
 
 

 

 

 

                                        

 

 

                   

                                                                  

 

                                                                  

 
 

Protrusion Length of the Blade 
 
 
 
 
 
 
 
 
 
 
 
 
Length of protrusion = t1 + t 2/ 2, but for your convenience you may just make it about 
0.3mm ~ 0.5mm beyond the blade holder tip. 
 

 Central line   

Blade 

  Blade tip 

offset

Thickness of the 
base paper (t 2) 

Thickness of 
the media (t1) 

Protrusion length 
of the blade 
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CorelDRAW Plug-In Instruction                         
AASII VBA Installer is applicable for CorelDRAW Version 11, 12, 13, 14, 15 
 
Installation 
 

1. Check the “AAS CorelDraw Installer” folder in Jaguar IV Installation CD, and double click 
the “AASIIVBAInstaller.exe” file to run the installation program.  

 
 
2. Press the “Install” button to begin installing GCC AASII CorelDRAW VBA. 
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User Instructions 
 

1. Run CorelDRAW to edit your graphics and select all images at once when you wish to 
plot.  

 
 
2. Select “Tools Visual Basic Play”.    

 
 
The Visual Basic for Applications Marcos window will pop up.  
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Select GCC_CorelDraw_AASII (GCCAASII_Draw12.gms) under the “Macros in” manual, and 
press “Run”.  

  
 
3. Click on “Apply”. 

 
 
 
 
 
 
 
 
 

CorelDRAW Plug-In                             A-3 

4-Point Positioning 
 Length: The length of marks 

 Range: 10mm~50mm 
 Optimized Setting: 25mm 

 Thickness: The line thickness of marks 
 Range: 1mm~2mm 
 Optimized Setting: 1mm 

 Margin: The distance between marks and images 
 Range: 1mm~50mm 
 Optimized Setting: 5mm 

 
Segmental Positioning 

 X Step: The distance of intermediate position on the X axis 
 Y Step: The distance of intermediate position on the Y axis 

 Range: 200mm~600mm 
 Optimized Setting: Less than 500mm 

 
Multiple Copies 

 No. of X Copies: The numbers of copies on X axis 
 No. of Y Copies: The numbers of copies on Y axis 

 Range: 1~50. (The more copies you make, the more 
time is needed for data transmission.) 

 Numbers of X Copies * Numbers of Y Copies = The total 
amount of image copies 

 Copies with outline：To show outlines of image graphics 
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The system will create the 4 marks as shown in the picture below. 

 
 
4. Now you can print out the image file with registration marks. 
 

Contour cutting through CorelDraw 
Step 1: Position the paper with registration marks printed by your printer on the GCC cutter. 
Step 2: Select “Files Print”. 
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Please note that if you use CorelDraw X5, you must follow the steps below. 
Click the “color” page and go to the “Color conversions performed by:” and then select the 
model name of you cutter.   

 
 
Step 2: Go to the “Layout” page and select Bottom left corner at “Reposition images to”. 

 
 
Step 3: Click “Print”. 
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You can also add a Hot Icon for the AAS II Plug-in 
 
Step 1: Select “Tools Customization Commands Macros”. 

 
 
Step 2: Choose【GCC_CorelDraw_AASII.GCCModule.GCC_AASII】and drag it to the 
“commands” bar.  

 
Step 3: If you want to have a different icon, select “Tools Customization Commands  
Appearance” to import a graphics for use as the icon. Choose an icon and press OK to 
complete this setting. 
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SignPal 8.5 Instruction                              
The new SignPal 8.5 Software is Windows Vista compatible and the SignPal Expert above 
versions support the AAS II contour cutting function of Jaguar IV and Puma III cutting plotters.  
 
Different to the previous SignPal 7.6 version, the SignPal 8.5 doesn’t come with a keypro 
dongle, which is replaced by a softkey to simplify the installation procedure. However, please 
note that the system must be connected to the Internet when launching the SignPal 8.5 
software for the first time with softkey. Internet access is required for online validation during the 
initial installation and for future online validations every 30 days. If the softkey is unable to 
connect to the Internet within a 30 day period, you will receive a message alerting you that you 
can only continue working with the software for another 10 days without connecting to the 
Internet. 
 
For users without Internet or broadband connection, please contact your local distributor to 
purchase hard keys (keypro dongle) and provide them your softkey ID & password for 
replacement. Your original softkey ID & password will be invalid after replacement, and the new 
hard key ID & password can work only with the dongle inserted to your computer. Please note 
that the softkey and hard key has different user ID number as following: 
Soft key IDs are 9xxxxx 
Hard key IDs are 5xxxxx 
 
 
SignPal 8.5 Instruction Index: 
[1] Installing the SignPal 8.5 software…………………….. P.01 
[2] Set up your GCC Cutter on Production Manager……. P.10 

-- SignPal AAS II Quick Start…………………………… P.13 
[3] Transferring a Software License Using Softkey ……… P.18 
[4] SignPal 8.5 Feature Lists……………………………….. P.20 
 
 
[1] Installing the SignPal 8.5 software 
To install the software, you must have Administrator privileges. To use the software, you must 
have Administrator or Power User privileges. See your Windows user guide for more 
information. 
1. Uninstall any previous version of the software. 
2. Insert the Installation DVD. 
3. Select a language and click OK. 
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4. Click Next. 

 

 
5. Read the Software License Agreement and select I accept the terms of the license 

agreement and click Next to accept. 
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6. If you did not have any previous versions of the software installed, skip to the next step. If 

you still have a previous version of the software installed, you will be prompted to overwrite 
the existing installation. Click Yes to overwrite any previous installation of the software. 

 

 
7. Select the features of the software that you want to install and click Next: 

• Check GCC Production Suite to install the software. 
• Check Samples to install sample files. 
• Check SafeNet Sentinel System Driver to install the software driver for this key. If you 

do not use this type of key, you do not need to install this driver. 

 

A. To change the default destination folder, click Browse and choose a new destination 
folder. 

B. To check that the drive you are installing to has enough space for the installation: 
a. Click Disk Space. 
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b. From the drop-down menu, select the drive you want to install to, and verify that it 
has enough space for the installation. 

c. Click OK. The installation drive changes to the selected drive when you click OK. 

 
8. Select the Program folder where the shortcut for the software will appear. A new folder is 

automatically created for the product. 
 
9. Click Next to install the software. 
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10. Once the installer is finished installing, the Install Manager opens. The Install Manager 
allows you to run a demo version of any available products, or to enter a password to access 
the software and any optional features. 

 
11. Do one of the following: 

• Check Run in demo mode to run a demo version of any available products in any 
available language. 

• Enter a Password, and then select a product from the Product list and a language from 
the Language list. Use the Add button to enter any additional passwords in the Optional 
Password section to unlock optional features. 

Password This is your main application password for the software.

Optional Password If you purchased additional options, you may enter the 
option passwords in this field to upgrade your software.

 
 
12. Click Done. 
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13. Check which icons and preferences you want to install: 

• Check Install to desktop to install a shortcut for the software on the desktop. 
• Check Install to startup items to install a shortcut for the software in the Startup folder 

of the Start menu. If this is done, each time the computer starts up, the software will 
automatically start up and minimize itself, displaying an icon in the system tray of the 
Windows system tray. 

• Check Clear Application's previous preferences to clear the preferences or clear the 
check box to retain old preferences. 

• Click OK. 
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14. Open SignPal 8.5v1 

 
 
15. As you have not registered before, please check on the box at bottom to register a new 

account.  

 
 
16. Input your personal information to complete the online registration. 
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17. If you have registered before, please enter your Registration code as below to open SignPal 

8.5v1 software. 
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[2] Set up your GCC Cutter on Production Manager 
 
1. Open Production Manager 8.5v1  
2. Choose and set up your GCC cutter. 

(Note that AAS II System only works on Jaguar IV and Puma III.) 
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3. Select File > Print Setup in SignPal Software. 
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4. Select the printer and paper size. 
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-- SignPal AASII Quick Start 
 
5. Use the Rectangle Tool to create a rectangle. 

 
 
6. Select Effect > Contour Cut. Then click ‘Apply’ in DesignCentral window. 
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7. Apply the contour cut mark of GCC AASII by selecting Effect > Contour Cut Mark.  

 
 
8. Select “GCC AASII” in SignPal DesignCentral window to create the AAS II registration marks 
(4-Point Positioning). Set the vales as 0.1cm or above and click ‘Apply’ in DesignCentral 
window. The value is to define the distance between registration marks and image area. If the 
value is less than 0.1cm, it is likely that the image will overlap the marks and result in bad 
cutting quality. 

 
 
9. There are three types of GCC AASII registration marks: 4-Point Positioning, Segmental 
Positioning, and Multiple Copies. To make ‘Segmental Positioning’ marks, please select “GCC 
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Segmentation” in DesignCentral window and then click ‘Apply’.  

 

 
10. For ‘Multiple Copies’, this function is not available in SignPal. Currently the ‘Multiple Copies’ 
function is only available under CorelDRAW plug-in. 
 
11. Select File > Print to print out the image. 
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12. Set the Scale as 100cm =1m (100%) in Print page. 

 

 
 
 
13. Load the printout vinyl on the plotter and select File > Cut Contour to send data. You can 
preview the job and change cutter’s parameter settings in ‘Properties’ tab of Cut Contour 
window. The Production Manager will be automatic activated to complete the job. 
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[3] Transferring a Software License Using Softkey 
 
Softkey allows you to transfer the software license to another computer by disabling the 
software license on one computer, and enabling it on another.  
 

Remarks: If you would like to upgrade or reinstall the Windows OS, please transfer your 
license before reinstallation. If your hard drive has been formatted and you forget to transfer 
license in advance, please provide your SignPal ID and password to your local distributor, 
they will contact GCC to reset your data, and you will be able to register again afterward. 

 
 
1. From the Help menu, mouse over Registration and select Transfer License. 

 
 
2. Click Yes to deactivate the software license on the computer currently running the software. 
You can reactivate the license on another computer or the same computer. 

 
 
3. Make note of your Registration ID and click OK. 
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4. Install the software on the computer you wish to transfer the license to. 
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[4] SignPal 8.5 Feature Lists 
 
  Pro Master Expert Apprentice 
Working with Files     
Job Info ● ● ●  
Templates ●    
Using DesignEditor     
DesignEditor ● ●   
Arranging Objects     
Distribute ●    
Working with Color     
Eyedropper ●    
Using Fill/Stroke Editor     
Overprint ● ● ● ● 
Working with Shapes     
Fan ●    
Arrow ●    
Working with Text     
Text Block Size ●    
URW Font Support Optional    
Working with Bitmaps     
Scanning ● ● ●  
Rasterize ●    
Colormode ●    
Marquee ● ●   
Move ● ●   
Eraser ● ●   
Pencil ● ●   
Fill ● ●   
Crop ● ●   
AutoTrace ● ● ●  
ColorTrace ●    
Working with Effects     
Color Trapping ●    
Graphic Styles     
Contour ● ● ●  
Working with Measurements and Labels     
Dimensions / Labels ● ●   
Automatic Dimension ● ●   
Dimension to Page ● ●   
Cutting your Design     
Cut/Plot ● ● ● ● 
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EasySIGN Instruction                               
The user manual of EasySIGN software is available on the EasySIGN program CD, or you can 
refer to the getting started manual available on the EasySIGN webpage at 
http://www.easysign.com/mainwebv1/DownGT.aspx.  
 
 
GCC AASII Corpmark System 
This application note will show you how to use the GCC AASII corpmark system. It assumes 
that you have installed your GCC plotter correctly, and that you are able to cut simple jobs on it. 
If not, please refer to the “Getting started” manual available through the menu "Help, Various, 
GettingStarted.pdf". 
 
1. Make or import a design 

 

You can either make the design in EasySIGN or import an 
existing design from another application. For making the design in 
EasySIGN refer to the "Getting Started" manual. To import a 
design (for example an Adobe illustrator file) into EasySIGN, use 
either the compatibility option, or use direct import (menu : "File, 
Import"). The easiest way is to use compatibility. To do this, start 
EasySIGN, then use the menu “File, Compatibility”, and click the 
software of your choice. 
 
This software will now start, and can be used to design or open 
the required job. Click the icon in the system tray to easily send 
the file into EasySIGN. 

 
2. Create print & cut lines. 

 

When your design is successfully imported into EasySIGN, you 
should then select the line or lines that you want to cut on your 
plotter. After selecting them, use the command “Edit, Convert to, 
Line type, Print&cut line”. The lines that will be cut are now shown 
in a dotted red line. Copy the design as you like. 

 
 

EasySIGN Instruction                              A-5 

http://www.easysign.com/mainwebv1/DownGT.aspx


                                                        Jaguar IV User Manual 

3. Enable the cropmarks. 

 

Right-click on an empty part of the worksheet, and 
choose the command “Cropmark settings”. 
 

 

 
This will show a dialog. 
 
Please tick the box called “Show Print & cut cropmarks”. 

 
Next, you need to make a choice which system that you want to use, there are three different 
systems: 
GCC AASII This system uses four cropmarks, and one copy. It is meant for 

jobs that are not very large (like 60 cm or smaller) and that are 
going to be printed on single sheets. 

GCC AASII, Multicopy Use this system when you want to cut multiple copies of a small 
job. This will give you very high accuracy, but the plotter will 
scan every copy of the job separately, which is of course slower 
than one big job. 

GCC AASII, Multisegment Use this system when the job is large. We recommend it for 
jobs bigger than 60 centimeter. It will place extra markers on the 
sheet, which will enhance the accuracy but will take extra time 
to scan. 

 
The size of the cropmarks is fixed at 25 mm. Just click “OK” to close the dialog. If you have 
chosen the “Multicopy” cropmarks, there will be extra settings for horizontal copies, vertical 
copies etc, please ignore these for now, we will get back to them later. 
 
 
 
 

EasySIGN Instruction                              A-5 



                                                        Jaguar IV User Manual 

4. Position the cropmark 

 

 
 
Use the panelling tool from the left toolbox to drag the 
cropmarks around your job. 
 
Make sure that the cropmarks have some white space 
around them, there should not be any objects inside them, to 
make sure they can be scanned accurately. 

 
5. Export the job for printing 
Your design is now ready for production. Click “File, Export”, and a dialog will come up that 
enables you to create a file. We advise you to use “EPS Encapsulated Postscript (*.EPS)” as 
the output format, this can be read by any RIP or other print software. Print the resulting EPS 
file with the software of your choice. 
 
6. Cut the result 
Place the resulting print in your plotter. Set the plotter to “offline” and use the arrow keys to 
position the laser within the lower right cropmark, then set the plotter to “online”. 
 

 

If you have chosen the cropmarks “Multicopy”, there is one 
extra step: right-click the page and go to the “Cropmark 
settings” dialog again. In the dialog, enter the correct values 
for “nr. Of copies horizontal”, “Nr of copies vertical” and 
“Copy distance horizontal”, “copy distance vertical”, then click 
“OK”. 
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In the EasySIGN software, choose “File, Plotting”. A dialog will come up that allows you to 
change the plotter settings. 
 

 
 
Just make sure that the following settings are made: 
 
Alignment plotting (1) Switched on 

 
Normal line (2) Switched off 

 
Print and cut line (3) Switched on 

 
 
Then click “OK”. Your plotter will then start scanning the cropmarks, and after that the job will be 
cut. 
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The user manual of GreatCut software is available on the GCC installation CD. 
 
GCC AASII System 
Below are step-by-step instructions when using the AAS function of GreatCut software. 
 
Step 1 Import the image you want to print and cut. 

 
 
Step 2 Add the contour line. 

 

 The value of Contour Offset should be ≥ 0.5mm. 

GreatCut Instruction                               
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Step 3 Add the registration marks 
A. Set up the value of registration marks. 

 
 

 

The value of width should be ≥ 1.0mm. 
 
 
 
 
 
 
 

GreatCut Instruction                              A-5 



                                                        Jaguar IV User Manual 

B. Set the registration marks. 

 

 
 
Step 4 Select the whole image including registration marks and click the multiple copies 
button. 
 

  
Note: The spacing of vertical & horizontal (Offset X & Y) should be ≥ 20mm or = 0mm. 
 
Step 5 Print out the image. 
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Step 6 Set up the multiple copies function with GCC cutting plotter.  
*Please note that you cannot select the whole images when output the multiple copies of 
images. You only need to select the contour line of original one and set up the value with Cocut 
Pro 4X4 and then you can send it to GCC cutting plotter. See the example as below. 
 
Right: (You should select the contour line but not the image.) 

 
 
Wrong: (You cannot select the whole images.) 
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Now you can output the image. 

 
 
A. Before output, you need to set up your cutter. 
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B. Select the series of cutter and the USB port.  

 
 
C. Set up the number of copies you need to cut here. 
Note:  
1. The number of copies and distance between copies should be the same as you made 

before (Step 4).  
2. You should confirm that the option of objects must show “Selected objects”. 
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Step 6 You now have a perfectly cut image. 
Enjoy! 
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